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System Requirements

Basic data collection or graphing, without video
• Windows 10 (32 or 64 bit) with 4 GB RAM. We recommend that Windows 10 users keep their systems
upgraded to Windows 10 1607 or newer and routinely apply updates from Microsoft for the optimal
experience in using Logger Pro.
• MacOS 10.13, 10.14, or 10.15. We recommend that Mac users upgrade their systems through Apple's
software update on a regular basis for the optimal experience in using Logger Pro.
• Logger Pro 3.16 and newer is no longer tested with Windows 7, 8, or 8.1. It may be compatible with these
operating systems but Vernier no longer asserts support for them. Windows 7 is no longer supported by
Microsoft. Microsoft ceases Windows 8.1 support in January, 2023.
• Go Wireless Temperature (GW-TEMP) is compatible with Windows 10 version 1607 only. A compatible
Bluetooth 4.0 transceiver is required. Mac users of GW-TEMP requires 10.13 or newer. GW-TEMP is not
supported on Windows 10 version 1703 (Creators Update) or newer as the Windows Bluetooth technology
stack was completely redesigned by Microsoft in that release.
• Logger Pro requires approximately 200/380 MB (Mac/Windows) disk storage. About 140/290 MB
(Mac/Windows)additional temporary disk space is needed during the installation process; you should have at
least 550/830 MB (Mac/Windows) free space prior to installation to allow the installation to complete
successfully and retain some space for creating user files during normal use.
• Computer display resolution 1024x768 or higher is strongly recommended. Lower resolutions may result in
important controls being hidden
• Data collection requires one or more of the following interfaces: LabQuest Stream, LabQuest Mini,
LabQuest 2, LabQuest, LabPro, Go! Temp, Go! Link, Go! Motion, WDSS, GW-TEMP, Vernier
Spectrometers including the Go Direct SpectroVis® Plus Spectrophotometer, Fluorescent Spectrometer,
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select Ocean Optics Spectrometers, Vernier GPS, Mini GC, Watts Up? Pro, OHAUS Scout Pro or
Adventurer Pro balance.
• Previous releases of Logger Pro are available for special applications. Contact Vernier for more information.
• Video resolutions less than 1024x768 are fully supported by Logger Pro 3.4.6 for non-video applications.
• Window 2000 is supported by Logger Pro 3.6.0.
• Windows 98 SE & Me are supported by Logger Pro 3.4.6.
• Mac OS 9 is supported by Logger Pro 3.4.2
• macOS 10.2 is supported by Logger Pro 3.4.5
• macOS 10.3 is supported by Logger Pro 3.6.1
• macOS 10.4, 10.5, and 10.6 are supported by Logger Pro 3.8.5.1
• macOS 10.7 is supported by Logger Pro 3.9
• macOS 10.8 is supported by Logger Pro 3.11
• macOS 10.9 is supported by Logger Pro 3.12
• macOS 10.10 – 10.12 is supported by Logger Pro 3.15
• Windows 7 is supported by Logger Pro 3.15
• Windows 8.0 is supported by Logger Pro 3.10.1
• Windows 8.1 is supported by Logger Pro 3.15
• Windows XP and Vista are supported by Logger Pro 3.8.7
• Windows NT is supported by version 3.2.1 of Logger Pro 3. Windows NT does not support any USB devices.
• Windows 95 and Mac OS 8 are supported by Logger Pro 2.2.1.
Video Functions
•
•
•
•
•
•
•
•
•
•
•

For video playback or extended data collection a faster processor and more memory are strongly suggested.
Windows 10 with DirectX 11 or newer and OS compatible drivers installed.
Macintosh macOS 10.13 or better.
User video files can be quite large and require substantially more disk storage space.
For Windows: 2 GHz single-core processor or any multi-core processor and 8 GB RAM, and at least 10 GB
available hard disk space for temporary storage.
For Mac: Intel processor and 4 GB RAM, and at least 10 GB available hard disk space for temporary storage.
Routine video capture and storage will require additional disk space over time. High resolution movies will
consume more disk storage very quickly.
Screen resolution of at least 1024x768.
Compatible camera with updated drivers for your target computer
A minimal system may sometimes exhibit skipped, black, or duplicated frames in video. Faster systems will
exhibit fewer such problems.
Modern videos can be quite large and may exceed Logger Pro memory allocation. Reducing resolution
and/or duration with conversion and editing tools suited to the purpose may be required for some video
scenarios. Single movies lasting 15 seconds at 1080p should have no issues on modern systems; longer
movies may need to be at a lower resolution for adequate performance. 4K resolution movies up to 30
seconds long have been shown to load and play on reasonably modern machines although the load time can
take a few minutes

Go Wireless Temperature (GW-TEMP) (Bluetooth 4.0/BLE/Bluetooth Smart)
• For macOS, GW-TEMP requires macOS 10.13 or newer ; a Mac-compatible Bluetooth 4.0 radio (built-in or
add-on).
• For Windows, GW-TEMP requires Windows 10 version 1607; a Windows-compatible Bluetooth 4.0 radio
(built-in or add-on). No other version of Windows supports GW-TEMP
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Go Direct™
• Logger Pro currently supports the Go Direct SpectroVis® Plus via the USB interface only; Bluetooth
connectivity is not supported.
• Logger Pro does not support any other Go Direct products; for Go Direct, please see
http://www.vernier.com/products/software/graphical-analysis/
Wireless / Bluetooth with Vernier Wireless Dynamics Sensor System (WDSS)
• For Windows, WDSS requires Windows 7, Windows 8.1, or Windows 10 with the Microsoft Bluetooth
Driver and a Bluetooth radio compatible with the installed driver (built-in or add-on radio). Certain
“Widcomm” or “Broadcom” Bluetooth radios are supported. Vernier recommends using the Microsoft
Bluetooth driver whenever possible for such radios; however, latest Broadcom drivers and radios have been
shown to work with Logger Pro.
• For Macintosh, WDSS requires a Mac-compatible Bluetooth radio (built-in or add-on).
• For recommended Bluetooth radios or other Bluetooth/WDSS related information, visit
www.vernier.com/bthelp
Data Sharing
• For Windows, Data Sharing requires installation of Apple's Bonjour for networking support. Note that
Bonjour Print Services may be inadequate for Data Sharing. You must install Bonjour as provided by the
Logger Pro installer if you wish to use Data Sharing. The Windows installer does not install or enable Data
Sharing by default; it must be selected during install from the Custom Setup. Data Sharing on Windows
requires 1.2 Mb additional disk space.
• Enabling Data Sharing on Windows requires enabling the Windows firewall to allow the computer to
communicate with the network through a designated communications port. When you first enable Data
Sharing from within Logger Pro (via File>Data Sharing... pulldown menu in Logger Pro), the operating
system will present a Windows firewall dialog that must be approved for Data Sharing to function on the
Windows machine.
• Data Sharing users of Logger Pro must note the port number the server is using. This is particularly
important for users attempting to communicate via the web application (via a URL in a web browser). You'll
need to specify the port in the URL, e.g. http://myloggermachine.local:8080 where port 8080 is the port
number specified in the Logger Pro Data Sharing dialog.
• For Macs, Bonjour is already installed on your machine. Data Sharing is installed by default but not enabled.
Do NOT attempt to change the location of the Data Share installation. The above notes regarding enabling
Data Sharing from within Logger Pro apply to the Mac as well; except that typically there is no need to
configure the Mac firewall.

Install Notes
In general a computer should have the most recent updates from the operating system vendor (Apple or Microsoft)
applied before attempting to install Logger Pro (or really any software package unless there are specific reasons not
to) On Windows, it is especially important to avoid connecting a Vernier device to the computer before or during
installation of Logger Pro (or other Vernier software) Please read the minimum and recommended requirements for
Logger Pro above for the best experience with installing and using Logger Pro.
Logger Pro uses MSVC redistributables on Windows to provide essential functionality. Logger Pro attempts to
install these packages; however, machine configurations and permissions vary widely and sometimes the installation
of the redistributables can fail. In these cases, one may install the needed redistributables independently of Logger
Pro. Windows 7 uses the 2013 version of the redistributable and Windows 10 uses the 2015 or 2017 version. These
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can be obtained directly from Microsoft at https://support.microsoft.com/en-us/help/2977003/the-latest-supportedvisual-c-downloads Be sure to install the 32 bit versions (x86) (even on 64 bit systems)
Vernier Data Sharing is installed on Macs by default but left disabled. Installation on Windows is optional through
the installer's custom setup dialog. After installation on Windows, you must enable the function. The first time you
enable Data Sharing on Windows you will be prompted by the operating system's firewall to allow the network port
to be used for communications. If you specify a port differing from the default (8080), you should make note of it
for all potential Data Sharing client users. If you change the computer's network, you may see the firewall prompt
again.
Always first install Logger Pro before connecting any Vernier device via USB for the first time.
Starting with Logger Pro 3.15 (2018Q1), old Vernier device drivers are removed in favor of newer WinUSB drivers.
During the transition from old to new drivers for the various Vernier devices there was a mixture of old and new
drivers on Windows targets. The transitional period started with Logger Pro 3.8.5 (in 2012) with the introduction of
the LabQuest2 and concluded with Logger Pro 3.13 when the venerable LabPro was converted to use the WinUSB
stack. Vernier no longer distributes the old Jungo WinDriver device drivers for Vernier devices.
Logger Pro 2, Logger Lite, Graphical Analysis, LabQuest Emulator, and Logger Pro 3 will coexist on a single
computer.
Logger Pro is supported in the following languages: Arabic, Czech, English, Finnish, German, Greek, Spanish,
French, Italian, Dutch, Polish, Portuguese, Russian, Slovak, Swedish, Simplified and Traditional Chinese, Thai,
Turkish, Ukrainian, and Korean.
There is an interaction between the Logger Pro installer and Texas Instruments TI Connect uninstaller. If TI
Connect has been installed and subsequently removed, Logger Pro installer will refuse to run. To install Logger Pro
3 in this situation, first reinstall TI Connect 1.6 or newer. You can download an installer from
http://education.ti.com.

Windows Network Installation/Remote Deployment
• An installer for Windows that does not prompt for user input is available by request. This is useful for remote
or network managed installations of Logger Pro, as this silent installer (packaged as a .msi) can be caused to
run on a remote computer via Group Policy or otherwise, and the installation will proceed. Installation on
Windows 7 systems may require User Access Control (UAC) changes (temporarily) in order to complete the
installation via the silent installer. Such UAC changes are ultimately the responsibility of the computer's
administrator and/or network management tools. “Wininstall” and image based installers are not generally
supported as device driver installations are necessary to work with Logger Pro and part of the install msi.
Write to info@vernier.com for more information.
• Data Sharing functionality depends on Apple's Bonjour software. Apple's Bonjour software is not included
in the silent installer for Windows. Windows machines needing to run Data Sharing MUST be installed
using the full installer provided by CD or Web. Apple's Bonjour Print Services does NOT support Data
Sharing.
• Logger Pro depends on MSVC redistributable packages from Microsoft for Windows functionality. The
“silent” installer does not include or install those packages due to limitations in MSI deployments. Network
and Remote deployments must ensure the 2013 or 2015 (at minimum) x86 versions of these packages are
installed on the Windows 7 or Windows 10 target machines respectively.
• We do not recommend installing Logger Pro to a network location for shared access, because the necessary
drivers will not be present on client machines.
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• We do not recommend re-packaging a Logger Pro installation for remote deployment (as in Wininstall),
because driver installation requires that a secondary installer execute at install time. Please use a Vernier
supplied silent installer with your remote deployment tools to accomplish needed remote installation
scenarios.

What's Changed in Logger Pro 3.16

Significant Defect Resolutions
• Logger Pro will now launch in French on French-Canadian Windows systems. Note that Logger Pro is not
fully localized to fr-CA locales.
• Some animated vector experiment files were restored in English Sample Data/Physics
New Feature
• Video playback reworked for macOS 10.15 Catalina and newer.
Platform Support
• macOS 10.15 (Catalina) is supported; there were numerous areas and functions in Logger Pro that were
adversely affected by Catalina:
• Video
• SpectroVis connectivity
• Ohaus connectivity
• Windows 10 1909 is supported.

Logger Pro 3.16 Known Issues

LQ Stream Bluetooth Discovery and Pairing Consistency
Bluetooth discovery, pairing, and connection to the LQ Stream via BT is different on macOS and Windows.
LabPro Windows Driver Limitation
LabPro connectivity on Windows changed due to a driver change. As a result, Logger Lite and Logger Pro MUST
be of the same “generation”; otherwise LabPro will fail to connect. Logger Pro 3.13 and Logger Lite 1.9.1 may be
used together on the same machine. Logger Lite 1.9 and earlier are NOT compatible with Logger Pro 3.13.
Likewise Logger Lite 1.9.1 is not compatible with any Logger Pro prior to 3.13.
Video Limitations
Video capture and image capture are not supported in macOS.
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Large video files take a long time to load after a movie is inserted in a Logger Pro experiment. For example a 30
second 4k resolution (3840x2160) video is about 93 MB in size and takes about 4 minutes to load after the insert.
Only the machine OS itself offers feedback that something is happening during this time. After the movie loads,
playback is normal. Some machines may not play such movies smoothly.

GDX Devices Not Generally Supported
With the sole exception of the GDX-SVISPL when connected via USB, GDX devices are not supported in Logger
Pro. Please use Graphical Analysis 4.0 or newer for data collection with GDX probes and sensors.
.ambl files (produced with Graphical Analysis 4.0 or newer may be opened or imported into Logger Pro 3.14.1 or
newer for further use and analysis if desired.

Ohaus Tare Operation Timeouts
Logger Pro connects to select Ohaus balances; however, when using the “Zero” or “Tare” button on the balance
itself, it is possible to inadvertently disconnect the device. This is particularly true if you are using a more sensitive
Ohaus model and/or if the balance's environment is unstable (excessive vibration and/or noise). The issue is that the
balance temporarily stops communicating while it stabilizes after the button depress; if this interval is sufficiently
long (the balance has some difficulty stabilizing) Logger Pro believes the balance has been disconnected. If this
occurs you may address the issue by reducing the vibration and noise in the environment before depressing the
balance's zero button, use Logger Pro's toolbar zero button (which alerts Logger Pro prior to telling the balance to
tare), or increase the timeout setting in UserSettings.txt (contact Vernier for more detail).

Disabling Automatic Behavior
Logger Pro 3 can be configured to not automatically setup for collection based on the sensor connected in support of
certain curricula; however, many devices do not yet allow “manual” setups. Examples include Spectrometers, Ohaus
balances, Go!Temp, and Go!Motion. Only sensors which use the LabPro, LabQuest, LabQuest Mini, or Go!Link
may be used in the manual setups.

LabQuest file Compatibility
Logger Pro 3.7 or newer can open most LabQuest files correctly. Data columns will be translated correctly.
However, in some cases there will be errors in calculated column translation, breaking the data import. In most cases
you can manually recreate the calculated columns in Logger Pro to recover the information or use fully supported
equation forms in files meant for interchange between Logger Pro and LabQuest.
Similarly, LabQuest App can open many Logger Pro files when transferred to the LabQuest using the LabQuest
Browser in Logger Pro. Elements not supported on LabQuest will be ignored, such as text annotations or movies.
While LabQuest App does support calculated columns, the possible calculations are much more limited than in
Logger Pro. As a result, some calculated columns will not be translated for use in LabQuest App.

LabQuest Device Compatibility
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Logger Pro 3.16 can be used with LabQuest 1.0,1.1, 1.1.1, 1.2, 1.3, 1.4, 1.5, 1.5.1, 1,6, 1.7, 1.7.1, 2.0, 2.0.1, 2.0.2,
2.1, 2.2, 2.3.3,2.4, 2.5, 2.6, 2.6.1, 2.6.2, 2.6.3, 2.7, 2.7.1, 2.7.2, 2.8, and through 2.8.5 software. If a LabQuest with
1.0 software is detected, a warning will be displayed advising that the LabQuest unit be upgraded. This message will
be displayed every time the LabQuest is detected, but the LabQuest can still be used for most applications. If a
Logger Pro feature requiring newer LabQuest software is used, unexpected results such as freezing, crashing, or
data loss may occur. Power Amp and Function Generator functionality is only available on version 1.3 of LabQuest
or newer. We strongly recommend updating LabQuest to 1.7.6 or newer. LabQuest 2 hardware ships with LabQuest
2.8.5 or newer software. See www.vernier.com/labquest/updates/ for information on updates for the original
LabQuest. See https://www.vernier.com/downloads/labquest-2-updates/ for information on updates for the
LabQuest 2.

Windows 7
The behavior of USB devices after a computer sleep/wake cycle on Windows 7 may differ from prior Windows
operating systems. For example an interface connected to Logger Pro (not actively collecting data) may lose the
connection to the interface when the computer wakes from a sleep state.
Typically the computer enters a sleep state as the result of the computer's energy settings. When Logger Pro is
actively collecting data the program prevents the computer from sleeping; however, if the interface is merely
connected but not collecting, Logger Pro will allow the sleep cycle to start.
If your Windows 7 installation was installed fresh (not an upgrade from Vista) then you will likely see the interface
fail to reconnect upon computer wake. Upgrades from Vista retain the Vista behavior and the interface will
reconnect automatically upon computer wake. If you encounter problems with USB connected interfaces in
Windows 7 upon a computer waking from sleep, it is recommended that you disallow sleep, disconnect interfaces
when done with active collection, or set the time to commence sleep well beyond the anticipated use of Logger Pro
on that computer.
In the event an interface fails to reconnect, shut down Logger Pro, disconnect the interface, reconnect, and invoke
Logger Pro again. The interface should then connect without a problem.
Logitech 4000 cameras are not supported; use Logitech 5000 model instead.
Uninstalling 3.8.4 from the control panel will complain about an unknown publisher. This does not affect upgrades
from prior versions. To workaround the issue, simply ignore the unknown publisher warning and allow the
uninstaller to remove Logger Pro 3.8.4 as desired.
Installing 3.8.6 on systems not connected to the internet AND not updated since October 10, 2010 by Microsoft
update will complain about an unidentified publisher. The installer is signed; however, UAC will complain as the
root certificate from VeriSign is outdated.

Windows 10
Windows 10 operating system updates can be substantially different. For example the Bluetooth libraries which
Vernier uses for communication to our various Bluetooth enabled devices changed substantially between the so
called “Anniversary Update” and the “Creators Update” versions of Windows 10 in 2016 and 2017 respectively.
For this reason, Go Wireless Temperature is no longer supported in Logger Pro beyond Windows 10 Anniversary
Update.
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If you plan to use Go Wireless Temperature (GW-TEMP) with Logger Pro, you must use the Anniversary Update to
Windows 10; upgrading to the Creators Update or newer will break the connectivity to GW-TEMP.

Mac
Proscope HR is recommended for Macs.
ProScope HR “B” model requires the latest ProScope HR driver from the vendor website (www.bodelin.com). Both
Mac and Windows users should download and install the latest appropriate driver. Use of the ProScope HR in
Logger Pro with outdated drivers will exhibit video “breakup” or “tearing”.
Mac “forced sleep” will interfere with connectivity via USB to interfaces. Active collections with Logger Pro are
not generally affected; however, if you are running Logger Pro on a laptop and close the lid, this will force the sleep
and your data collection will be interrupted. If you intend a long duration collection, particularly with a long
interval between samples, or you intend a long duration monitoring of sensor values without collection, we
recommend you turn off sleep in the energy portion of the System Preferences.

Spectrometers
Although multiple spectrometers may be connected at the same time and used with Logger Pro, such use is not
supported by Vernier. We recommend that only one spectrometer be connected at a time.
If you experience connection issues with the USB2000 or other Ocean Optics spectrometers after installing the latest
Logger Pro and rebooting the machine (particularly on Vista), please run Windows Update to ensure that Vista is
fully updated with all Microsoft's updates for the operating system and try connecting after updates are complete.
Vista 32 bit systems that are not up to date with Microsoft's updates may exhibit connection problems particularly
with the USB2000 unit.
Some computers may not supply enough current for Spectrometer lamps via the USB port connection. If you
experience problems calibrating and suspect this may be the cause, contact Vernier for more information and
reference TIL #2408. Eliminating USB extensions or unpowered hubs can eliminate some connection issues.
SpectroVis Plus can hang Logger Pro on Macintosh if the spectrometer is left connected as the machine boots. It is
recommended that the SpectroVis Plus is physically disconnected from machines that will be shut down.
Logger Pro will report too generically, “Could not collect from Device”, if the spectrometer lamp is weak or burns
out. Please check that the spectrometer lamp is brightly lit while it is connected to Logger Pro if this message is
seen.

GPS
At this time only Garmin devices are supported with the Garmin data transfer protocol. NMEA data protocols are
not supported in 3.8.4. Only select Garmin units and the Vernier GPS devices are supported at this time; please see
www.vernier.com/gps for supported models.
COM interfaces are shown for connected VGPS devices. Attempting to re-connect to a Vernier GPS (VGPS)
manually via a COM port (after disconnection for whatever reason) will not yield a usable connection and may lock
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up or crash Logger Pro. If there is a need to reconnect to the VGPS it is currently required for you to use the Vernier
GPS port designation in the Experiment>Connect Interface>GPS> menu.
VGPS connection to Mac 10.6 (Snow Leopard) mistakenly will display a networking dialog. Users of VGPS on
Snow Leopard may simply cancel from that dialog and use the device normally in Logger Pro. VGPS is not
supported on Yosemite 10.10.

Adventurer Pro
Pressing the “Unit” button on the Ohaus scale may lead to incorrect values being reported by Logger Pro. Use the
Calibrate dialog in Logger Pro to set the units.

Watts Up? Pro
Although the device contains on-board memory and internally logs data values, Logger Pro does not support
retrieving that stored data (remote data retrieval). To use the “Watts Up? Pro” device with Logger Pro you must
collect data with the device connected.

Mac OS 10.8 & 10.9
Users of “Mountain Lion” or “Mavericks must use Logger Pro 3.8.6.2 or newer. Earlier versions of Logger Pro will
not run on these newer versions of Mac OS.

Mac OS 10.9 & 10.10
10.9 energy management is more assertive. Mac Energy Saver preferences may interfere with Logger Pro's
connections to interfaces or data collection. Logger Pro 3.9 and newer adjusts its energy demands on the Mac
according to needs of the interfaces and/or data collection. With typical data collection rates for most devices and
sensors, Logger Pro 3.9 and newer should not encounter any issue. Problems such as disconnected interfaces or
interrupted long duration data collection may be avoided by either adjusting the energy saver preferences to avoid
the computer suspending. If desired or necessary one may change the “App Nap” setting on the Logger Pro
application file itself. For more information please see http://www.vernier.com/til/3190
General Issues and Suggestions for Logger Pro 3.16
• Currently you cannot insert the same movie in an experiment file (cmbl) more than once and have them share
the same video analysis data set. Duplicate movies will have independent data sets.
• Calculated columns' equations based on two or more data columns measuring the same physical quantity
(such as temperature) from sensor data collected using the LabQuest interface will not be preserved if saved
as QMBL format and read by Logger Pro. For example, if you measure two temperatures with the LabQuest
(standalone) and save a QMBL formatted file set with a calculated column which depends on those two
temperatures, save, and reopen that QMBL formatted file in Logger Pro, the calculated column will not work
as expected. The workaround is to re-create the calculated column in Logger Pro.
• Do not connect the USB cable to LabPro until it is powered and has given its start-up beeps.
• Computer sleep and energy settings may interfere with Logger Pro operation – particularly on newer
operating systems and/or hardware that are more aggressive in energy conservation measures to preserve
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•
•
•
•
•
•
•

battery life. If you encounter interface disconnects and/or problems with data collection (particularly with
slow or overnight collections, you may wish to experiment with different energy settings.Microsoft's
Windows Update can cause overnight collections to be terminated due to rebooting. Suspend Windows
Update temporarily when running overnight collections. Don't forget to turn Windows Update back on when
you are finished with such long-term collections.
Meters monitoring Drop Counter sensors will display the last point taken.
System response time may increase when collecting a large number of data points.
When using a Stainless Steel Temperature Probe remotely, the default calibration will be used. A custom
calibration can be performed, but will be used only when the collection is done while attached to a computer.
When updating the LabPro OS on multiple LabPros, do not disconnect a LabPro until after you click OK on
the dialog box announcing a successful update. (LabPro OS updates from Logger Pro were removed as of
Logger Pro 3.11 and newer.)
User parameters cannot start with z.
On Macintosh only, picture analysis may not work if the inserted image is a .pct file. To avoid the problem,
convert to .jpg in an image editing program.
OS 10.10 and later systems with a primary language set to something other than English impacts font
selection dialogs. The default font is not selected or highlighted. Users may select other fonts without issue
however.

File Compatibility
Logger Pro 3.16 can open files created in Logger Pro 3.0, 3.1, 3.2, 3.2.1, 3.3, 3.4, 3.4.1, 3.4.2, 3.4.5, 3.4.6, 3.5.0,
3.6.0, 3.6.1,3.7, 3.8, 3.8.2, 3.8.3, 3.8.4, 3.8.4.2, 3.8.5, 3.8.5.1, 3.8.6, 3.8.6.1, 3.8.6.2, 3.8.7, 3.9,3.10.1, 3.10.2, 3.11,
3.12, 3.13, 3.14.1 and 3.15. Logger Pro 3.16 can also open files created in Logger Lite (any version) and Graphical
Analysis 3.0, 3.1, 3.2, 3.4, and 3.8.4. Logger Pro 3.16 can open .ambl files from Graphical Analysis 4.2+ releases.
Files created by Logger Pro 3.16 in general can be opened in version 3.3 through 3.15 , but if newer features are
used in the file compared to the earlier version, it will not be fully functional. For specific limitations, see Specific
File Issues below.
Files with movies in .mov (QuickTime containers) may not load properly in 3.12 and newer.. If the underlying
codec is mp4 then movies may playback fine in 3.12 and newer on Windows. It may be necessary to convert
movies in .mov format to use the .mp4 codec to ensure playback on Windows in 3.12 and beyond as QuickTime is
no longer used by Logger Pro on Windows since Apple no longer supports QT on Windows.
Files created by Logger Pro 3.16 cannot be opened in Logger Pro 3.0, 3.1 or 3.2.1. No version of Graphical
Analysis can open any Logger Pro files.

Specific File Issues
• Files created in Logger Pro 3.16 containing calculated columns with the degree symbol or Greek micro (µ)
in the column name will not open correctly in Logger Pro 3.3. To avoid the problem, remove the degree
symbol or Greek micro character while in version 3.16 Or, in version 3.3, find the Â° or Âµ you see in the
column name and remove the Â.
• Files created in Logger Pro 3.3 or earlier containing column names that use the pipe character (|) will not
open correctly in Logger Pro 3.16. To resolve this problem, remove the pipe character from the column
names while using Logger Pro 3.3 or earlier.
• Files created in 3.16 that include calculated columns referring to a specific data set will not open properly in
Logger Pro 3.3.
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• Logger Pro 3.16 continues to support auto-save files as a safeguard against unexpected interruption of data
collection. Increasingly, experiment files can contain large numbers of samples that take a long time to save
to disk. To remedy this in 3.6.0 or later, auto-save files are now saved in a new internal format allowing, for
example, files that formerly took 40 seconds to save, take only one second to auto-save.
• Files containing cosine squared, Gaussian, or normalized Gaussian fits or models created in versions newer
than 3.8.4.2 will not open or will not display such fits or models correctly in prior versions (3.8.4.2 or
earlier). Files with such data should always be open in 3.8.5 or newer.

Logger Pro 3 Change History

Logger Pro 3.15

Significant Defect Resolutions
Fixed:
Obsolete device drivers are now purged from Windows during install. Old “Jungo” based drivers could confuse
Windows and LabQuest Mini interfaces could be rendered unusable.
Partial installations of MSVC++ 2015 dlls could lead to inability to invoke Logger Pro on some Windows 10
systems. The Logger Pro installer now always attempts to install the 2015 redistributable on Windows 10 end
user installs. (Note that administrative silent installation via Group Policy does not install the redistributable by
design; GP deployment models using the “silent” msi deliverable are expected to manage those dependencies)

New Feature
Logger Pro supports high resolution monitors. Logger Pro renders in a more readable and pleasant way for
default scaling factors used for windows on so called HD displays (4K, Retina, UHD, etc) 2k resolutions are
also enhanced.

Platform Support
macOS 10.14 is officially supported. Windows 10 1803 is officially supported.

Logger Pro 3.14.1

Significant Defect Resolutions
Fixed:
Peak integrations done with overly constrained window objects would sometime force an assert and abnormal
termination of Logger Pro on Windows due to invalid bitmap draws. This was a longstanding defect in drawing
code.
Ocean Optics UV-Vis spectrometer connection would give error about a missing IDSX string. This regression
introduced with 3.14 was addressed.
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New Feature
Files from Graphical Analysis 4.0 (.ambl extension) for Chrome, Windows, Mac, iOS may be opened or
imported into Logger Pro

Platform Support
macOS 10.13 is supported.

Logger Pro 3.14

New Hardware (Devices or Sensors) Support
• Fluorescent Spectrometer VSP-FUV
OS Support
Windows

W10, W8.1, & W7
Mac

10.12, 10.11, & 10.10

Significant Defect Resolutions
Fixed: Windows Update Installers disabled Go Wireless Temperature menu pick

Language Support
Ukrainian

Dropped OS Support
none

Dropped Hardware Support

none.
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Logger Pro 3.13

New Interface Support
LQ-STREAM Bluetooth Connectivity Support

New Hardware (Devices or Sensors) Support
Go Direct SpectroVis Plus Spectrophotometer (GDX-SVISPL)
Fluorescent Spectrometer VSP-FUV
OHAUS Scout® (newest hardware): OHS-222, OHS-123, OHS-422
LabPro driver on Windows updated to use WinUSB (see below)
OS Support
Windows

W10, W8.1, & W7
Mac

10.12, 10.11, & 10.10
Significant Defect Resolutions
Slovak experiments and support files translated / improved
Tab key clears your data in the table on Mac
Experiment File Changes
Physical Science with Vernier updates

35c Graphing Your Motion.cmbl
Middle School Science with Vernier updates

09 A Good Sock.cmbl
11 Solar Homes.cmbl
27 Magnetic Field.cmbl
33a Graphing Motion.cmbl
33b Graphing Motion.cmbl
33c Graphing Motion.cmbl
33d Graphing Motion.cmbl
33e Graphing Motion.cmbl
33f Graphing Motion.cmbl
34 Speeding Up.cmbl
Dropped OS Support
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macOS 10.9 is no longer supported; Windows 10 or 8.1 is recommended for current Windows 8 users.
Dropped Hardware Support
None in this release; however, LabPro drivers have changed on Windows

Logger Pro 3.12

Video playback restored on Windows (without relying on deprecated QuickTime)

Separate Windows Updater / Installer
There are now two separate Windows Logger Pro installation files available. The installer does not prompt for a
password, and is obtained from the user account section of vernier.com. The updater will only update an existing
Logger Pro installation. The updater can be downloaded without login from vernier.com.

Experiment File Changes
•

Experiments containing movies were changed to ensure they use .mp4 or other usable containing formats
and codecs to allow Windows playback via Windows Media Foundation calls rather than QuickTime which
was removed from Logger Pro in 3.11.

•

Added "Physics with Video Analysis" to the published set of experiments in Logger Pro.

•

Added "3 and 4-Point Testing" to the "Structures & Materials Tester" in "Probes & Sensors"

New Language Support
Slovak is now a supported language in Logger Pro.

Logger Pro 3.11

Sensor and Device Support
Go Wireless Temperature (GW-TEMP) (Only supported on Mac 10.10 or newer or on Windows 10 or newer)
LabQuest Stream Interface support added
GPS Support on Mac has been removed
Palm Pilot support has been removed
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LabPro OS (firmware) update removed.
QuickTime installer for Windows has been removed from the installer
Experiment File Changes
•

Added Solar Energy Experiment Files

•

Updated Spanish Translated Experiments

Logger Pro 3.10.2

Significant Defects & Issues Resolved
LabQuest Mini connectivity to Logger Pro for Mac users of El Capitan (10.11) restored. El Capitan introduced
some timing related issues that made the USB connectivity to the LabQuest Mini interface problematic for most, if
not all users of El Capitan. Vernier recommends all Mac users install 3.10.2. Windows installations are unaffected
and installations from the CD for Windows will continue to install 3.10.1.

Platform Support
Mac OS 10.11 (El Capitan) Support

Logger Pro 3.10.1

New Features
Weighted Curve Fits

Curve fits have been reimplemented, offering greater speed, more consistent results, and optional point
weighting. Repeated parameters in custom curve fits are now allowed. Fits have been tested successfully against
NIST standard curve fits. You can now optionally specify a weighting column for use in any curve fit.
Weighting is direct, meaning that a point with a weight of two is counted twice in fit calculations.
Correlation Values for All Curve Fits

Correlations are calculated for all curve fits and displayed in the curve fit helper annotation for the fit. In
the past this was only available on linear fits.

Export to plot.ly

Logger Pro data can now be exported to the Plotly online graphing service. An account is not required, but is
recommended. An internet connection is required. See plot.ly for more information about the service.
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Save to LabArchives

Logger Pro files can be saved directly to LabArchives. An account with labarchives.com is required. An
internet connection is required. Logger Pro files stored on LabArchives can be retrieved. At this time accessory
files, such as videos or images, are not automatically saved to LabArchive servers.

Significant Defects & Issues Resolved
Export CSV with maximum precision
Copy text from curve fit helpers
A number of crashes and asserts fixed.

Experiment File Changes
VSMT files in Probes & Sensors/Structures & Materials updated.
EKG files (Biology w/ Vernier, Human Physiology w/ Vernier, and others) updated to use filters.

Platform Support
Windows 10 Support
Provisional Mac OS 10.11 (El Capitan) Support
Sensor and Device Support

Sound Level Sensor (SLS-BTA)
Platinum-Cell Conductivity Probe (CONPT-BTA)
High Performance Gas Pressure Sensor (PS400-BTA)

Logger Pro 3.9

Platform Support
Macs running Yosemite (OS 10.10) are fully supported; as always, we recommend that machines be updated to the
latest version of any supported version. OS 10.10.1 is current as of this writing
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XP & Vista are no longer supported; see notes above for the final versions of Logger Pro for systems no longer
supported.
Mac OS 10.6 is no longer supported; see notes above for the final versions of Logger Pro for systems no longer
supported.

Significant Defects & Issues Resolved
Macs running Logger Pro on Yosemite (OS 10.10) with a non-English primary language will no longer crash due to
an inability to find the system font.
Better support for Mac's “App Nap” feature enables a better user experience when connected to a Vernier interface
via USB and when performing “long and slow” data collection. App Nap appeared first in Mac OS 10.9.
Logger Pro Data Sharing server reconfigured to support Chrome App clients. Chrome App clients (hosted on
Chrome books or in Chrome browsers) could not properly communicate with Logger Pro Data Sharing sources due
to a security setting in the web server embedded in Logger Pro prior to 3.9.

Sensor and Device Support

Support for the Vernier Structures and Materials Tester (VSMT)

Logger Pro 3.8.7

New Sensor Support
Vernier Energy Sensor (VES-BTA) including six new automatic setups for sensor combinations for temperature
sensors, light sensors, and the anemometer..

Feature Changes
Support added for “raised dot” printers for Braille output
VES automatic detection with sensor combinations.
Uncertainty Boxes may be enabled from graph options.
Comma Separated Value (CSV) Import/Export handling of localized values using a comma as a radix separator

Significant Defects & Issues Resolved
Data Sharing component for existing installations now correctly updated by installation.
17

Data Sharing Web App updated to version 1.4 supporting IE 11 browsers.
Data Sharing display of scientific notation corrected.
An assert for a missing accessibility string corrected / avoided.
“Display larger text” for helper object text now provides a larger font.
Motion Encoder Cart can now be used with motion detector experiments.

Logger Pro 3.8.6.2

Operating System Support
Windows 8.1 is supported.
Mac OS 10.9 (Mavericks) is supported.

New Sensor Support
PAR-BTA, PAR Sensor
VSP-EM, Vernier Emissions Spectrometer
VSP-UV Vernier UV-VIS Spectrometer
VDS-EC Vernier Motion Encoder System

Feature Changes
Upgrades Data Sharing Web Application to version 1.3 now supporting use with Internet Explorer 10.
Updates to published Physics with Vernier experiment files.

Significant Defects & Issues Resolved
Greek Blood Pressure files fully translated.
Consistent CSV export / import localization support.
Data set order presentation from Data Sharing more consistent.
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Better toolbar appearance in localized versions.

Logger Pro 3.8.6.1

Operating System Support
Windows 8 is supported.

New Sensor Support
ODO-BTA (Optical Dissolved Oxygen) is supported.

Feature Changes
Google Maps Export now uses version 3 of the Google Maps API. Large data set export has better capacity and
rendering performance support.
Additional sensor supporting experiment files included for Goniometer (GNM-BTA), Vernier Projectile Launcher
(VPL), and Instrumentation Amplifier (INA-BTA) in the sensor folder of experiments. The files support use of the
Goniometer in EMG experiments, the INA with high and low pass signal filtering, and the Time of Flight
experiment with the VPL.

Significant Defects & Issues Resolved
Most often used dialogs with numeric fields now validate user input immediately rather than after the dialog is
closed preventing invalid inputs and more timely feedback.
DCU dialog now may be entered without connected sensors for improved usability and user experimentation.
Improved Data Sharing performance for some scenarios.
Numerous Video Capture defects resolved.
Better defaults for wavelength range and other spectrometer settings for SpectroVis line of spectrometers.
Zeroing two or more sensors no longer causes sensor re-initialization.
Over 150 other issues resolved.
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Logger Pro 3.8.6

Operating System Support
Windows 8 is provisionally supported. Logger Pro 3.8.6 has been tested with pre-release versions of Windows 8
and no significant issues have been found.
Mac OS 10.8 (Mountain Lion) is supported. Logger Pro 3.8.6 has been tested the released 10.8. Full Screen mode is
supported. Gatekeeper will identify the installer package and executable as authored by Vernier Software &
Technology.

New Features
Enhanced DCU control to support STEM activities.
Digital Filtering (reduce noise in sensor data)
Optional Support for Vernier Data Sharing (as part of Vernier's Connected Science System®)

New Sensor Support
Ethanol Sensor – allows experiments in anaerobic respiration.
Pyranometer – supports measuring solar radiation in Watts / Meter Squared

New Language Support
Danish, Finnish, and Turkish are now available for Logger Pro.

Logger Pro 3.8.5.1

Significant Defects & Issues Resolved
Logger Pro 3.8.5.1 corrects regressions in behavior introduced by 3.8.5 for LabPro users doing repeated collection
runs with some sensors, or in some instances simply stopping the collection using the LabPro.
. In 3.8.5, repeated collections with digital sensors (Radiation Monitor or Drop Counter) plugged into the LabPro
would drop the connection to the sensor or sometimes the LabPro at the end of a collect. This defect also would
cause a minor live readout glitch with the LabPro and the Dual Range Force sensor where spurious readings were
visible after the collection ended. And lastly, some Motion Detector configurations and usage patterns could cause
problems with the live audio feedback clicks from the Motion Detector. All of these issues stemmed from a single
defect in 3.8.5 and are corrected in 3.8.5.1.
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Logger Pro 3.8.5

New/Changed Device/Interface/Sensor Support
• LabQuest 2 is first supported.
• LabQuest Mini Firmware Upgrade to 1.85 for better support of Chemical Polarimeter, Diffraction Apparatus,
and Projectile Launcher released after the initial release of the LabQuest Mini.
• Diffraction Apparatus
New Language Support

In addition to the prior 13 languages, 2 additional languages are now supported:
• Swedish
• Greek

Logger Pro 3.8.4.2

New Device/Interface/Sensor Support
• Supports new Chemical Polarimeter (CHEM-POL)
• Supports Constant Current System (CCS-BTA)
• Supports new Projectile Launcher (VPL)
New Features
• New cosine squared curve fit
Significant Defects & Issues Resolved
• Ohaus balance connectivity made more reliable and deterministic.
New Computer Operating System Support
• Mac OSX 10.7 (Lion) Supported

Logger Pro 3.8.4

New Device/Interface/Sensor Support
•
•
•
•

Improved WDSS Bluetooth Support – newer Broadcom (Widcomm) Bluetooth radios support.
Supports new Anemometer
Supports new Melt Station
Supports new 30-V Voltage Probe
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New Features
Data Marks / Tags

Data Marks enable annotations of data events during a time-based data collection. Data Marks are associated with
the actual data cell(s) taken at the user selected time during the collection. Such markers might for instance be
associated with a change of phase during a melting session with the new Melt Station or any other sensor where you
may wish to note an event during the collection. Press the <d> key during a data collection places a Data Mark and
displays an associated helper box for further use. Double-clicking the associated helper box allows you to enter text
associated with that mark.
Data Tagging enables annotations of a specific sample or ranges of samples after a collection or for collections
utilizing non-time-based modes. Similar to Data Marks, Data Tagging can associate additional information with
specific samples. To tag a sample or range of samples, select the sample or range from the graphed data and then
press the <d> key. You may also select a data sample range from the data table if you wish.
Note that Data Markers and Tags are distinct from text annotations in that the Mark or Tag is associated with a
distinct sample in the data table and not just a location on a graph as is the case for text annotations. Use Data
Marks as part of a time-based collection during the collection. Use Data Tags after a collection. Data Marks may be
distinguished by a small black triangle rendered at the top right of the “helper” box.
Data Marker/Tag text may be entered by double-clicking on the marker “helper” box and entering desired text in the
provided field.

Video Analysis Enhancements

More video analysis options are available. Video frames may be skipped while adding points. The first point
marked may set time zero. Center of mass studies can be done with video analysis.

Other Changes
The Logger Pro Windows installer has been rewritten to better support international or second language
installations, enable better Windows support of Broadcom based Bluetooth radios, enable better installer behavior
when the same or newer version of QuickTime is already installed, rectify some driver issues that plague some XP
installations, and provide MSI based “silent installation” for improved remote/network managed deployment usage.
Czech, Dutch, and Polish were added as supported languages.

Logger Pro 3.8.3

New Device/Interface/Sensor Support
• Latest VGPS devices (MTK) Support
• Ocean Optics Spectrometers supported on Windows 7 and Vista 64-bit operating systems.
• Drop Counter Automatic Configuration Feature Added
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Other Changes
For the first time both English and international versions of Logger Pro 3 are concurrently released. English users in
most cases will not notice any difference. However, if an English user wishes to enable one or more available
alternate languages such as Spanish or French along with English it is relatively simple to do so by creating
additional desktop shortcuts that specify a “/Lang” parameter to the Logger Pro 3 executable. For example, Spanish
Logger Pro 3 on an English system may be enabled via a copy of the regular desktop shortcut and adding “
/Lang=es” to the Target line in the shortcut. – contact Vernier for more information.
Current international users will enjoy more timely and seamless support of their native language on their choice of
Windows operating systems (International Logger Pro 3 is not supported on macOS) International users wishing to
also access the English version (or other installed languages) of Logger Pro 3 on their native systems may do so by
creating an additional shortcut(s) as above (e.g. “/Lang=en” for English). Logger Pro 3.8.3 replaces all prior
versions of Logger Pro International.
Graphing optimized for user entered data when no interface is connected; no connecting lines are drawn and the
scale is set to 0 to 10.

Logger Pro 3.8.2

New Device/Interface/Sensor Support
•
•
•
•

Vernier LabQuest Mini (see the Vernier website for more information: http://www.vernier.com/lqmini )
SpectroVis Plus
Windows 7 64-bit operating systems support.
Mac macOS 10.6 (Snow Leopard) support.

Other Changes
The location for Experiment templates and examples is changed for 3.8.2 to mesh with operating systems providing
a “Common Application Data” location and avoid problematic automatic Windows behavior like “Shadow Copies”
resulting from Logger Pro writing to “Program Files” routinely outside of the installation process. As a result, first
time opens will default to the Common Application Data location (which varies by Operating System) for access to
the provided Experiments. New users of Logger Pro will not notice this change; however, long time users of Logger
Pro will no longer find the “Experiments” folder in the “Program Files” or “Applications” folders. The new
locations are:
• /Library/Application Support/Logger Pro for macOS
• [Startup Drive Letter]:\Documents and Settings\All Users\Application Data\Vernier\Logger Pro 3\{language
code} for Windows XP
• [Startup Drive Letter]:\ProgramData\Vernier\Logger Pro 3\{language code} for Vista & Windows 7 systems
For the convenience of long time users of Logger Pro 3, an alias or shortcut that points to the “Experiments” folder
may still be found in the “Program Files” or “Applications” folder.
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Logger Pro 3.8

New Device/Interface/Sensor Support
• Vernier Mini GC (see the Vernier website http://www.vernier.com/probes/gc-mini.html for more
information)
• LabQuest Function Generator (with LabQuest 1.3)
• LabQuest Power Amplifier (with LabQuest 1.3)
• Vernier VGPS-PL
• Watts Up? Pro
Windows 7 & Mac macOS 10.6 OS Provisional Support
Logger Pro is now provisionally supported on Windows 7 32-bit and 64-bit OS and macOS 10.6 (Snow
Leopard) Note that 10.6 is only available on Intel architecture Macs. Logger Pro 3.8 was tested on prerelease versions of both Windows 7 and macOS 10.6 and found to be compatible. It is possible however
that final released versions of these operating systems from Microsoft and Apple could introduce changes
from the pre-released versions tested during Logger Pro 3.8 development and evaluation that could be
detrimental to Logger Pro 3.8's operation. Windows 7 and macOS 10.6 users are cautioned to perform their
own evaluation of Logger Pro 3.8 on the released versions of these operating systems prior to committing
to any large scale deployments of Logger Pro 3.8 on these new operating systems.

New Features
• Peak Area Measurement (Peak Integration) When you choose Peak Integration from the Analyze menu, a
dialog will be displayed. Use the graph in the Peak Integration dialog to select the left and right boundaries
of the peak you want to integrate. You can auto-scale, zoom in, and zoom out using the buttons. This feature
primarily supports the analysis of chromatographs from the Vernier Mini Gas Chromatograph (GC)
• Function Generation with connected 1.3 LabQuest. To set up the Function Generator, open the LabQuest
sensor dialog by clicking the LabQuest icon in the toolbar or choosing Set Up Sensors > LabQuest from the
Experiment menu.
• Power Amplification with connected 1.3 LabQuest and Vernier's PAMP. To set up the Power Amplifier,
connect PAMP to LabQuest and then open the LabQuest sensor dialog by clicking the LabQuest icon in the
toolbar or choosing Set Up Sensors > LabQuest from the Experiment menu.
Significant Defects & Issues Resolved
In prior releases, unplugging devices would not remove them from the Live Readout bar under some conditions.
This could confuse some users that did not always carefully disconnect and connect devices at the beginning and
end of Logger Pro sessions. Device signatures from the low level API were corrected to match what Logger Pro
expected in these cases so that the confusing behavior no longer occurs.
In 3.7, VGPS users of Logger Pro in the eastern hemisphere could encounter longitudes that were incorrectly signed.
Such users would have to introduce calculated columns to correct the sign prior to using such data. Logger Pro 3.8
corrects this error.
Using a heat pulser (HP-BTD) with the 1.2 LabQuest interface attached to Logger Pro 3.7 did not work. Using a 1.3
LabQuest interface with Logger Pro 3.8 corrects issues with the heat pulser via the LabQuest interface. LabPro users
are unaffected.

24

LabPro users attempting to upgrade LabPro firmware with Logger Pro 3.7 “over the wire” firmware updates would
fail with an assert. The issue is corrected in Logger Pro 3.8. Note that upgrades are enforced for LabPro firmware
older than 6.26. (LabPro firmware updates were removed from Logger Pro 3.11 and newer.)

Logger Pro 3.7

New Device/Interface/Sensor Support
• LabQuest 1.2 devices are fully supported including sensor support for wide range temperature, heat pulser,
and DCU
• Vernier GPS Device
64 bit Vista OS Support
Qualified and signed 64 bit Device drivers for LabQuest and LabPro interfaces are now available. The Logger Pro
installer automatically installs these new drivers enabling full support of Logger Pro functionality on this 64 bit
operating system.
Better Date & Time Display
Date and Time display on graphs is improved, providing better user feedback and the ability to plot time-based data
in much more meaningful and useful ways.
Improved GPS Functionality
• Signal strength indication for VGPS devices in Live Readouts.
• Ability to select coordinate units (decimal degrees, degrees + minutes, UTM)
• Better automatic data columns based on collection mode / sensor configuration.
Changes in Auto Behavior
• An entry in the usersettings.txt file, “IDSX_MANUAL_SENSOR_CONFIG” may be used to specify if
automatic setup of sensors should be turned off to support curricula that have students perform setup for data
collection, etc.
• The usersettings.txt is found in the Vernier installation folder; you may find this in typical installations under
your Local Disk C: > Program Files > Vernier Software > Logger Pro 3 > en-US > Support >
Usersettings.txt.
• In the Usersettings.txt file find the IDSX_MANUAL_SENSOR_CONFIG entry and change the value to “1”
to enable the manual mode.
Installer Packaging Improvements
The Windows installer has been migrated to use a MSI package which supports easier deployment by IT personnel
to multiple computers by scripting. Contact Vernier for more information.
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Significant Defects & Issues Resolved
• Fixed: Multiplication in LabQuest calculated column fails to transfer to LP
• Fixed: Leaving LabQuest Interface window displayed in Logger Pro will cause interface disconnects.
• Fixed: cannot correctly zero a motion detector when using LabPro
Other Issues Resolved in 3.7
• Fuller set of calculated column equations supported in Logger Pro / LabQuest data exchanges.
• Improved LabQuest remote setup.

Logger Pro 3.6.1

New Device/Interface/Sensor Support
• LabQuest 1.1 devices fully supported including sensor support for radiation and rotary motion
• Support for LabQuest 1.1 internal microphone
New Icon
Logger Pro 3.6.1 features new icons for the application and documents. The new icons are related to new icons used
in Logger Lite 1.4.
Significant Defects & Issues Resolved
• Crashes with WDSS when used with WIDCOMM Bluetooth driver
Other Issues Resolved in 3.6.1
• Clarified wording in Remote Data Retrieval dialogs

Logger Pro 3.6.0

New Device/Interface Support
• LabQuest devices supported (Note: International users (3.6.0i) may encounter specific file interchange issues
, see LabQuest 1.2 or 1.3 notes at the end of this document.)
• New SpectroVis Spectrometer supported
• Global Positioning System (GPS) devices supported on Mac.
New Program Features
• Auto-saving during collecting is significantly faster.
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Significant Defects & Issues Resolved
• Improved reliability during sensor confirmation and LabPro firmware updates.
• “Rough and slow graphing” on Macs displaying pixel ratio resolutions other than 1:1.
Other Issues Resolved in 3.6.0
• On Windows, the installers now install a version (7.2) of QuickTime supporting Vista computers.

Logger Pro 3.5.0

New Computer Operating System Support
• Windows Vista is supported on Vista compatible hardware. LabPro drivers are signed for Vista.
New Device/Interface Support
•
•
•
•

Logitech 5000 camera for video capture.
Garmin GPS receiver models GPSmap 60CS and GPSmap 76S.
New Vernier CO2 sensors with selectable range.
Vernier and Ocean Optics Spectrometers are now supported on Intel Macs.

New Program Features
• Improved axis based zoom in/out on graphs; uses and extends the “stretchy axis” concept.
• Mac allows customization of the toolbar to suit user preferences.
• Mac User Interface conforms much more closely to Apple Human Interface Guidelines and thus should be
more similar to other Mac applications. Mac Logger Pro text handling now has access to more of Mac native
text handling and features.
• Numerous spectrometer connection and functional improvements. Connection/disconnection is faster and
connection does not require a separate scan operation. Peak resolutions are generally cleaner and noise is
diminished. Calibrations may reliably take advantage of averaging.
• Automatic graph match exercise creation feature. Access in Settings for (file-name) in the File menu.
• Empty Latest data sets are now hidden on remote data retrieval.
• Movies can now be swapped without altering video analysis environment.
• Global, as opposed to per-user, preferences.
• Sensor confirmation dialog now allows connection of WDSS.
• Additional picture and movie file types available in Mac insert picture/movie object open dialogs.
Significant Defects & Issues Resolved
•
•
•
•
•
•

Macintosh long-term data collection spanning more than 3 days is more reliable.
Curve fits no longer require sorting data.
Numerous graphics and print issues.
Spectrometer calibration more robust.
Improved stability during drop counter calibration.
Improved reliability during sensor confirmation and LabPro firmware updates.
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Other Issues Resolved in 3.5.0
•
•
•
•
•
•

Radiation monitor and events with entry or selected events again works.
Removed some limitations on columns choice for horizontal axis.
Allow simultaneous heart rate monitor and blood pressure measurement.
Restored robust movie file location search feature on Macs.
User parameter units no longer lost.
Data Pro Hot-sync from Palm on Mac again automatically retrieves data into Logger Pro.

Logger Pro 3.4.6

New Computer Hardware Support
• Intel Architecture Macintosh computers are supported natively for the first time in Logger Pro 3.4.6 through
the new Apple Universal Binary.
New Device/Interface Support
• IR Temperature Probe
• Garmin GPS USB interface initially supporting GPS Garmin Models Vista Cx and GPSmap 76S
• WDSS WIDCOMM interface (alternate Bluetooth driver) for increased Bluetooth configuration options on
Windows. Note: Vernier strongly recommends using Microsoft's Bluetooth drivers on Windows XP SP2
whenever possible.
New Program Features
• Time Offset option for curve fit
• Import Logger Pro experiment files; combine several students' results in one Logger Pro file.
Significant Defects & Issues Resolved
•
•
•
•
•

Keyboard Triggers now work properly
WDSS repeat remote setup no longer loses trigger setting
GO!Motion dialog for keeping remote data on device is no longer missing
Eliminated assert on video analysis WUtils.cpp when user deletes the time column
Improved tracking of multiple objects in video analysis

Logger Pro 3.4.5

New Device Support
•
•
•
•
•

Spectrometers powered by Ocean Optics (XP, Windows 2000, macOS 10.3.9 or newer)
Wireless Dynamics Sensor System (WDSS) (XP SP 2, macOS 10.3.9 or newer)
Global Positioning Satellite (GPS) Receivers by Garmin (Windows only)
Adventurer Pro
Soil Moisture Sensor
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• Digital Video compatible cameras and devices.
New Program Features
•
•
•
•
•
•
•
•
•

Log Graphs (Single and Double Y Axis)
Point and Click video / data synchronization
Full spectrum mode, and visible spectrum graphing with Spectrometers
Data synchronization with multiple WDSS devices (facilitates dynamics experiments that were problematic
in the past)
Export Latitude / Longitude with other data annotations as a Google Map
Electrophoresis Gel Analysis
Interpolation Calculator
Photo Distance Object
Auto resizing text annotations

Significant Defects & Issues Resolved
On Windows systems, Logger Pro files on read-only media (CDs etc) would fail to open due to a low level
Microsoft defect. This has been corrected and Logger Pro now opens these files successfully.
Data synchronization with multiple sources is much improved and more consistent.

Logger Pro 3.4.2

International
Logger Pro 3.4.2 provides an upgrade path for 3.2.1 international users. International users should examine release
note entries below for versions since 3.2.1 to gain an understanding of what has changed from 3.2.1 to 3.4.2.

Silent Installation
Logger Pro 3.4.2 provides and allows a silent install option for system maintainers of a large collection of machines
for English only. For more information on the silent install option, please contact Vernier Software & Technology.

Issues Resolved
Over 80 issues were addressed by 3.4.2. The following list reflects some of the more notable issues resolved.
• Curve fits no longer fail when columns have single Greek character short column names.
• The correct curve fit now loads on opening all files saved with curve fits in versions before 3.4. This only
affected saved curve fits after the polynomial fit in the curve fit menu.
• Removed a program failure that would occur if the user deleted the base column of a graph and stored the
latest run.
• Changed the slope calculation to correctly account for blank cells.
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•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•

Text import now works correctly for utf8 text encoding (special characters).
LabPro OS update no longer causes an intermittent failure.
Curve fits with single-character x-axis labels now correctly use that label.
Fixed program failure on keyboard entry when automatic linear fit helper object is the only object selected.
Graph Options dialog now respects manual scale settings.
Better LabPro driver install on Windows 2000.
Fixed a LabPro power saving feature defect that prevented the unit from powering down in all situations.
Fixed a Mac OS Logger Pro crash when a default folder name was left empty in the start-up file.
Fixed an issue with FFT where removal of one input column accidentally removed the source.
Fixed text edit issues in text boxes where some characters were turned into Greek characters.
Fixed text select and replace cursor placement issues that made certain text manipulations difficult.
Data Delete Column should now ONLY show columns that can be deleted.
Corrected a situation that froze Logger Pro 3.4.1 using an analog sensor and a photogate sensor.
Opening Digital Meter Options dialog no longer intermittently shows “invalid parameter” message.
Fixed intermittent and rare file corruption problems.
Fixed TI Graph Link silver cable problem when upgrading from Logger Pro 3.1.
Non-numeric entries in numeric columns are no longer lost.

Logger Pro 3.4.1

Serial LabPro Communications
Fixed issue with slow (<0.2 Hz) data collection when using serial connection to LabPro.

Logger Pro 3.4

Supported Operating Systems
Support added for macOS 10.4.1 and newer.
Signed Driver
LabPro USB driver for Windows XP is now signed by Microsoft. A signed driver can be installed without
displaying a hardware wizard or requiring an administrator login. Initial Logger Pro installation still requires
administrative rights, but connecting a LabPro to a new USB port will no longer require such rights.
Support for New Devices
• Support added for Go! Motion.
• Support added for TI-84 and TI-89 Titanium USB direct cables.
• Support for new sensors: Blood Pressure, Charge, Spirometer, and Hand Dynamometer.
User Parameters
User parameters allow control of values used in calculations, triggering, and analog output functions.
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Control objects for user parameters have been added to the Insert menu. Parameter controls are page objects, much
like a digital meter, that allow adjustment of parameter values using mouse or cursor keys.

Curve Fits and Modeling
Function Plotting. Modeling no longer requires the presence of data to draw a function on a graph, so a function may
be plotted alone.
Modeling is improved. Manual curve fits may be modified after the fit is drawn on the main graph.
Curve fits now optionally stored as a calculated column of user parameters. Curve fits as parameters allows the fit to
be manually adjusted after the fit.

Video Features
• Video capture from many USB camera devices, with automatic insertion of movies in Logger Pro pages, has
been added to the Insert menu.
• When an experiment file containing inserted videos or pictures is created or saved, the referenced video or
picture file is copied to the same file location.
• Video capture done with data collection will be inserted and already synchronized, ready for replay.
• Video analysis of a still photo.
• Rotated coordinate systems for video analysis allows one-dimensional analysis of motion that is neither
vertical nor horizontal.
• Display of current frame time and frame number in videos.
Graph Features
Double Y graphs allow plotting of values with different magnitudes on a single graph, such as pH and temperature
vs. time.
Adaptive point protectors for clearer printing of graphs with multiple traces. Point protectors are placed sparsely on
runs as markers.
Better use of color for distinguishing runs. Optionally Logger Pro will use a single color in each run.
Time of day and Date in Time column and graphs has been added.
Optionally, horizontal axis labels may be rotated for graphs
There is a new option to make all rows major tics on graphs. For example, a data table listing twelve month names
can be set to display all months on the horizontal axis.
Additional control of number displays added in data tables and graph labels. User can force scientific notation.

Styled Text
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You can customize the style of the text (including adding Greek characters) as it appears in text boxes, annotations,
and graph labels.
Data Collection
Automatic saving of backup data files in case of power loss or crash enabled.
Space bar toggles data collection on and off if the selected page object does not have space as a valid character. For
example, if a graph is selected, pressing the space bar will start and stop collection, just like the Collect button.
However, if a text object is selected pressing space will enter a space character. The space bar is a convenient way to
start data collection.
New unit-changing paradigm allows changing units after data collection. Units are no longer tied to a particular
calibration.

New Calculated Column Functions
•
•
•
•
•

Event counting with photogates
Modulo
Boolean functions
Collapse indirect for better display of photogate data
Blood pressure calculations

Improvements
It is now possible to collect data more slowly than one point every 4.4 hours when LabPro is connected to the
computer. Remote data collection continues to have the 4.4-hour upper limit to the time between points.
Improved speed for all Mac OS versions, especially OS 9. In particular, opening files with many calculated columns,
or storing runs with many calculated columns, is much faster.
Improved flexibility in displaying photogate data without blank cells. The data table can hide rows based on any
single column.
Improved examine mode for video analysis. Video now snaps to frame when a marked point is selected.
Additionally:
•
•
•
•
•
•

Support added for QuickTime 7.
Clarified sensor calibration dialog box.
Improved printing of fine graph lines by setting gray grid lines to black.
Sounds in videos are now enabled on all platforms.
Improved tolerance of videos with uneven time steps, making more videos usable for analysis.
The aspect ratio of an inserted video is preserved at file open.
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Logger Pro 3.3

Support for Multiple Devices
Logger Pro 3.3 supports LabPro, Go!Temp, Go! Link, and Ohaus Scout Pro balances. Up to four devices may be
used simultaneously, with no more than two LabPros. On Windows, only one Ohaus scale can be connected by
USB. Note: USB devices connect automatically if detected. Serial LabPro (and Ohaus on Windows) require manual
connection using Connect Interface from the Experiment menu.

Icons for On-Line Devices
The second row in the toolbar now holds icons for each on-line device, followed by any live readouts. These icons
are buttons to summon the sensor setup dialogs for each device. Offline devices do not appear in the toolbar, but are
available in the Experiment menu.

Keyboard triggering
Keyboard triggering is a new option that allows you to start data collection with minimal delay by pressing the
space-bar or return key on the keyboard. Enable keyboard triggering on the Data Collection dialog, Triggering tab.
When keyboard triggering is active, clicking the Collect button merely prepares the system for data collection;
collection begins at the next point when the space-bar is pressed.

Automatic Detection of Sensor Configuration
Logger Pro now detects the connection and removal of auto-ID sensors whenever live readouts are on and data
collection is not active. When a sensor is added, a column is added to the Data Table. When a sensor is removed, its
column is removed if the column is empty. To disable this behavior, turn off live readouts in the Experiment menu.

Automatic Updating of Page Objects
Logger Pro now automatically adds graphs or connects columns to existing graphs when sensors are added. This
behavior simplifies setup, but it can also disrupt existing page layouts. As a result there are two new options to
control automatic updates of page objects. You can separately enable or disable update page objects on FileNew
(the default is on) and after File  Open (the default is off).

Single-Point Calibration
Standard calibrations require two external references, but some sensors can be calibrated by setting an offset only,
such as correcting a barometer for altitude. Logger Pro now allows single-point calibrations for any sensor that can
be calibrated using two points.

Identify Column Data Source
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Now that Logger Pro collects data from multiple devices it can be confusing as to where a given column is getting
its values. You can now determine the source by device and channel number (e.g., LabPro 2, CH 3) by inspecting
the Column Options dialog for a given column. In addition, the interface dialogs (ExperimentsSet Up Sensors 
Show all Interfaces show the column name where the data from each channel is stored, in each sensor's Sensor Info
display.

Finer Control of Live Readouts
All live readouts can still be disabled through the experiment menu but individual columns can be controlled
through the column options. This can be very helpful to reduce the number of live readouts displayed on the tool
bar. You can now turn on live readouts for the Motion Detector, although then the detector will click at all times.

Export to GIS Format
Logger Pro can export data in a form recognized by GIS software such as ArcView by ESRI.

New Page Objects
There are three new page objects. The Thermometer resembles a glass thermometer and can be used to display
sensor readings. The Analog Gauge is a dial readout for sensor readings. The Animated Display is used to represent
the motion of objects, usually from a Motion Detector column.

New Global Preferences
New preferences have been added. Optionally you can turn on a list of recently used files to be displayed in the File
menu. This feature lets you quickly return to recent work, but some users may want to turn off the feature so that
students cannot easily find other student work. The default is off. You can turn on large toolbar buttons so that
Logger Pro will look nearly like Logger Lite. The default is set for standard Logger Pro buttons.

Supports New Sensors
The new Thermocouple (version shipping after May 2004) is now supported

Sensor Confirmation Dialog
The Sensor Confirmation dialog opens when you open an experiment file and Logger Pro does not detect all the
necessary sensors. In version 3.2.1 and earlier we assumed that some non-auto ID sensors were present. Now we
prompt, unless the Sensor Confirmation flag is cleared in the setting for that experiment file.
The Sensor Confirmation Dialog will disappear when you connect the requested auto ID sensors.
You can also indicate where any non-auto ID sensors are connected and manually close the dialog.
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Logger Pro File Compatibility
Logger Pro saves files in the .cmbl file format. Logger Pro opens .xmbl, .gmbl, and .cmbl files as saved by Logger
Pro version 3.0, 3.1, 3.2 and 3.2.1, and Logger Lite. Logger Pro will also open files saved in any version of
Graphical Analysis 3 (.ga3 extension).

Other Changes
•
•
•
•
•
•

Grouped graph behavior links axes and doesn’t group the objects themselves.
Page objects now click to the front like windows in Finder and Explorer.
Sensor polling for new auto ID sensors is now on whenever live readouts are on.
Option to hide helper objects added.
Predictions now take on the units of the graph.
If no interface is connected when Logger Pro is launched, there is no longer a prompt to connect an interface,
since Logger Pro is often used for manually entered data.

Experiment Files
• Experiment files have been updated.
• Experiment files have been added for Workshop Physics and CPU (Constructing Physics Understanding).
• Experiment files for Workshop Physics, CPU, Interactive Lecture Demonstrations, Real Time Physics, and
Tools for Scientific Thinking have been moved to a folder titled Additional Physics.

Logger Pro 3.2.1

Supported Operating Systems
Mac OSX 10.3 is now supported.

Enhancements
•
•
•
•

Several printing issues corrected.
Fixed problem with serial connection to LabPro and Events with Entry data collection.
Two-Photogate timing mode corrected.
Remote data collection for 12000 points and four sensors now works correctly.

Experiment Files
Experiment files have been updated.

International
Logger Pro 3.2.1 is more compatible with international options.
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Logger Pro File Compatibility
• Logger Pro files created in version 3.2 and 3.2.1 cannot be opened in older versions of Logger Pro.
• Logger Pro files created in version 3.0 and 3.1 may be opened in Logger Pro 3.2 and 3.2.1.

Logger Pro 3.2

Video Analysis
Quantitative position information can be obtained from inserted videos. User can set scale, define an origin, and
track the positions of up to three objects. Video analysis data may be synchronized with sensor data.

Strip Charts
A new strip chart graph type has been added. If the width of a strip chart is less than the data collection time, then
the strip chart will scroll right to left as data collection or replay proceeds.

Rate Functions
The rate functions used for heart rate and respiration rate calculations has been improved to use a moving window,
allowing more frequent updates to the reported values.

TI Connect Compatibility
Logger Pro 3.2 is compatible with TI Connect versions 1.1, 1.2 and 1.3, and will use the installed USB Graph Link
driver for calculator data import, if one is present.

Optional LabPro OS update
You have the option to update the LabPro Operating System (OS) from 6.26 to 6.27 to obtain improved Photogate
and remote data collection behavior. If your LabPro has an OS older than 6.26, Logger Pro 3.2 will require an
update to 6.27.

Other changes
•
•
•
•
•
•

New and better sensor select dialog, with groupings of sensors.
Handles 60 samples a minute or hour and other unusual values with better display of time values.
Comma decimal separator now supported in addition to North American standard period decimal separator.
Additional Tool Tips added.
Extra smart sensors are ignored when opening a file.
Stainless Steel Temperature probe calibration now supported using three reference temperatures.
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• Removed extra Motion Detector calibrations because you are able to remove automatically generated
calculated columns now and they will not come back.
• Data can now start before the movie and still be synced.
• Improved Motion Detector calibrating.
• Large number support increased to 1050.

Logger Pro 3.1
A major development in Logger Pro 3 is the addition of all the features of the Graphical Analysis 3 Program. Below
is an overview of these features.

New Feature: Import From TI Device
You can use Logger Pro 3 to transfer the data from a Texas Instruments graphing calculator to your computer for
analysis or printing. Supported calculators are the TI-73, TI-73 Explorer, TI-82, TI-83, TI-83 Plus, TI-83 Plus Silver
Edition, TI-84 Plus, TI-84 Plus Silver Edition, TI-85, TI-86, TI-89, TI-92, TI-92 Plus, and Voyage 200. To do this,
you need a TI-GRAPH LINK cable, which is part of the TI-GRAPH LINK package and is sold by Vernier Software
& Technology and other Texas Instruments dealers. This cable connects the TI graphing calculator to the serial or
USB port of your computer.

New Feature: Import From Data Pro
You can import data from a Palm hand-held running DataPro into Logger Pro 3 for analysis or printing by selecting
Import from…DataPro from the File menu. The Palm Hot-sync feature will also send data to Logger Pro. You will
need the DataPro package, which is sold by Vernier Software & Technology.

New Feature: Movies
You can synchronize data collection and a movie of the experiment so that as you replay the movie, the data are
replayed on the graph. Supported movie formats are Video clip (.avi) and all file formats supported by the
QuickTime player. For a complete list of supported formats, visit:
apple.com/quicktime/products/qt/specifications.html

New Feature: Draw Prediction
Added to Logger Pro 3 is the ability to predict what might happen in a given scenario. In certain lab experiments,
you might want students to predict what is going to happen before they collect data. When you draw a prediction in
Logger Pro 3 on the graphs, the prediction will be saved in the data table for comparisons.

New Feature: Control Devices
Using Logger Pro 3, you can power devices with an output signal from the function generator built into LabPro.
You can also power and control devices using the Digital Control Unit.
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New Feature: Pages
Logger Pro 3 now has pages. This allows you to have different layouts of data in a single file. One page might
contain a graph and table with five different data collections. Then on different pages you might perform
comparisons between different collections or just go into each collection in more detail. Each page can almost act as
a different file while still sharing data with all the other pages.

New Feature: Insert Additional Objects
Added to Logger Pro 3 is the ability to add different objects besides the normal table and graph. These include
rectangles and ovals. You can also add pictures to your experiment. Visual aids are especially useful for annotation,
documentation, or instruction for a particular experiment.

New Feature: Data Browser
The Data Browser is a container for all the data in a Logger Pro file. In contrast, a given data table will not
necessarily show all data columns.
For basic use of Logger Pro, you will not need to use the Data Browser. By default, all new data columns are added
to all data tables. However, for more complex Logger Pro sessions, you may find it useful to display only a subset
of the possible columns in a particular data table, or you may find it useful to not display a data table at all. In these
cases, you will use the Data Browser to manipulate data columns and data sets.

What Changed from Logger Pro 2 to Logger Pro 3
Below are questions you may ask if you are already familiar with older versions of Logger Pro. Also provided is a
list of improvements and new features of Logger Pro 3.

Interfaces
Logger Pro 3 supports the Vernier LabPro interface, the Vernier Go! Temp, the Vernier Go! Link, and the Ohaus
Scout Pro balance. You can import data from text files, Excel files, different TI Graphing Calculators using a TIGRAPH LINK cable, a Palm OS hand held using Data Pro and the LabPro. Logger Pro 3 will not work with the
ULI, Serial Box Interface, or the MPLI.

LabPro and Collect buttons
The “Collect” button will no longer disappear when an interface is not connected. Instead there is constant feedback
in the upper left-hand corner of the tool bar that tells the user whether or not the LabPro is connected. The Collect
button will be faded if LabPro is not connected or recognized.

Windows
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Logger Pro 3 now uses objects instead of windows. Every table, graph, meter, floating box and other window
previously available in Logger Pro 2 are now separate objects in Logger Pro 3. Each object can still be sized and
moved. Using the Page menu items, objects can be aligned, layered, grouped, un-grouped, and locked on a page. To
insert most objects, just select the object you wish to add from the Insert menu. Floating boxes, now called helper
objects, can still be found in the Analyze menu. Objects also have options, which can be opened by either double
clicking on an object or selecting the desired object and choosing it from the Options menu.

Data Runs
Runs from Logger Pro 2 are now called Data Sets in Logger Pro 3.

Calculated columns
Formula Columns are now called Calculated Columns in Logger Pro 3. Other than the name change, calculated
columns act the same way as Formula Columns in Logger Pro 2, with some additional features like error bar
calculations.

Supported File Formats
Logger Pro 3 can open files in Logger Pro 3 (.cmbl or .xmbl), Logger Lite (.gmbl) or Graphical Analysis 3 (.ga3)
formats.
The Import Text feature, available from the File menu, can import data saved with the Export Text menu item or
files created and saved from several other formats (e.g. Excel). The file must be in the tab-delimited text format used
by Export Text (a .txt, .TEXT, .dat or .csv extension). Data are imported only into the latest data columns. You can
also use this feature to import data prepared or collected in another program into Logger Pro.

Sensor Setup
The Setup menu has been removed. The Sensors Properties dialog has changed to the Sensor dialog, which can be
accessed through the Experiment menu by choosing Set Up Sensors  Show All Interfaces from the Experiment
menu. Each interface (LabPro, Go!Temp, Go! Link, or Ohaus balance) will have its own Sensor dialog.
If you are using an auto-ID sensor (such as a Stainless Steel Temperature Sensor or a Motion Detector), Logger Pro
will identify your sensor at launch and load a default data collection mode. If your sensor does not auto-ID, choose
an experiment file from the appropriate sensor folder or open the Sensor Setup dialog to manually configure Logger
Pro for you sensor.

Mode and Sampling
In Logger Pro 3 these two separate pages have been combined into the Data Collection dialog from the Experiment
menu. As you change the mode for the collection, you will notice the options available will also change according to
your choice. These options are similar to those in Logger Pro 2.
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Repeat mode
In Logger Pro 2 there was a separate Repeat mode for doing a Real Time Collection with repeats. In Logger Pro 3,
Repeat is a checkbox option on the Time Based collection mode page of the Data Collection dialog.

Photogate Timing modes
Photogate Timing modes are not available in the Data Collection menu. Click on the Photogate Channel Box in the
Sensor Setup window to change or select timing modes.
Logger Pro 3 also contains improved, more flexible functions (available in the New Calculated Column dialog from
the Data Menu) to create calculated columns based on Photogate data.
Radiation Monitor setup
Once the Radiation Monitor is set up in the Sensor Setup window, the sensor status will be shown. The reading will
be in Counts. The status of the Radiation Monitor is also displayed under the Toolbar. Click on the Radiation
Monitor Channel Box in the Sensor Setup window to change or select timing intervals.

FFT graph and table
To insert an FFT graph, just select it from the Insert menu under Additional Graphs. In Logger Pro 3 there is no
longer a separate FFT Table; instead FFT data are placed in the regular data table. The FFT Graph Options dialog is
similar to the FFT Options dialog found in Logger Pro 2 except the two pages, Graph Features and FFT, have been
combined into one page for easier access. FFTs have also been updated to allow more than one column to be plotted
on a single FFT graph.

Histogram graph and table
To insert a Histogram graph, select Histogram from the Insert menu under Additional Graphs. In Logger Pro 3 there
is no longer a separate Histogram Table; instead histogram data are placed in the regular data table. The Histogram
Graph Options dialog is similar to the Histogram Options dialog found in Logger Pro 2, but the Graph Features page
has been renamed to Graph Options and the Axis Options page is now the Bin & Count Options page. Histograms
have also been updated to allow more than one column to be plotted on a single Histogram graph.

Automatic/Manual Curve Fit
Both types of curve fits have been merged into a single dialog in Logger Pro 3. Logger Pro 3 includes all Logger
Pro 2 curve fit options and many new features. For automatic curve fits, you are now able to define your own
function for a curve fit. The preview window now acts like a normal graph with the ability to zoom and auto scale.
To switch between a manual and automatic curve fit, just click the appropriate radio button located in the upper right
of the dialog under Fit Type. After performing an automatic curve fit, you can switch to a manual curve fit to get an
even better fit if you desire. Sometimes it also helps to click the Try Fit button more than once to improve an
automatic curve fit.
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Auto scale axes
The functionality is now in the Axes Options tab of the Graph Options dialog, which can be called up by selecting
Graph Options from the Options menu or by double clicking on the graph. Clicking on the axis labels on the graph
may also change the axes. The scaling options for each axis are now independent of each other.

Printing
There is no longer an option to Print Screen. Instead, you can select Print from the File menu.

Remote data retrieval
Remote data retrieval from the LabPro is now in the Experiment menu. The functionality remains the same except
that when you setup the LabPro for remote data, you can now print out your collection settings. Retrieval of data
from the LabPro remains the same.

Calibration Folder
The calibration for sensors has been updated and is now stored in a database, so it's no longer necessary to supply a
calibration folder.

Experiment Folder
The experiment folder is now located within the default folder, which can be defined in the Preferences dialog.

Over Range Auto-scale option
The Over Range Auto-scale option in the Graph behavior preferences page in the Preferences dialog has been
removed. In Logger Pro 3 you can get the same effect by going to the Axes Options, which can be accessed either
through the Graph Options (from the Options menu or double clicking on the graph). There are scaling options for
each axis, so the auto-scaling can be independent of each other.

Default Interface
Logger Pro 3 allows the creation of offline interfaces, replacing the single default interface of Logger Pro 2.

Options menu
The Options item found in the Experiment menu in Logger Pro 2 has moved to the File menu and renamed Settings
for "this file.” You will find all of the experiment options in this dialog except the Enable automatic Curve Fit
check-box, which has been moved to the Preferences dialog. This new Settings dialog will save your options for the
entire file, even after closing the file.
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Store Latest Run
To store a set of data, choose Store Latest from the Experiment Menu.

Information about a file
The About "this file" item in the Help menu has been removed. In Logger Pro 3 you can place information about a
page in the Page Options item in the Page menu. You can set the Page Information text in the Page Options dialog
for page 1. You can also choose for it to be displayed when the page is first viewed, or when the file is opened.

Undo function
In Logger Pro 2 there was an undo command in the Edit menu. Logger Pro 3 expands on this command and allows
you to undo almost any action that you perform. Collecting data, deleting or inserting an object, or changing the
scale of the graph, for example can all be undone. If you perform too many undo operations, you now have the
option to perform a redo that essentially undoes an undo.

Text Annotation
Text Annotation in Logger Pro 3 has been updated with many new features. For one, each text annotation can be
connected to a point, thus describing information about what is happening to the graph at a particular point in time.
As the graph is moved, the text annotation will stay with its point. You can also have more than one text annotation
for a single point.

Stretchy Axes
Just outside the X or Y-axis line, you can use the cursor to manually rescale or stretch the axis.

LabPro Operating System
Logger Pro 3 requires at least LabPro operating system 6.26. If a LabPro is connected with an earlier version, a
dialog box will open offering to update the LabPro. You must update the LabPro to use it with Logger Pro 3.
Beginning in version 3.2.1, Logger Pro will update the LabPro OS to version 6.27. This update is optional, and be
applied by connecting a LabPro, clicking the LabPro icon in the toolbar, and clicking the Update LabPro OS button
in the Sensors dialog for that LabPro.
Note that LabPro OS updates are no longer supported in Logger Pro release 3.11 and newer.
In version 6.26 sensors were allowed to warm up after pressing the START/STOP button. In 6.27 the sensors are
warmed up at setup time. After any warmup period has elapsed, data collection begins immediately on pressing
START/STOP.
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Version 6.27 updates and fixes:
•
•
•
•

The build has DataMate 6.15 that includes the TI-73 Application.
Fixed problem where communications were ignored during sensor warm up period.
Fixed problem of photogate timebase and analog timebase being out of sync.
Fixed problem of a first point of monitored (not collected) data being max value when using high speed data
collection (DataMate),
• Fixed problem of corrupted data if photogate state transitions during start of pendulum experiment
• Fixed problem of using two Radiation monitors at the same time (Logger Pro)

LabQuest Operating System
LabQuest 2 OS release notes may be found at https://www.vernier.com/til/ and searching for “LabQuest Release
Notes”. LabQuest 1 release notes are summarized at http://www.vernier.com/support/updates/labquest/labq/

Vernier Software & Technology
info@vernier.com
www.vernier.com
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